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 Abstract:Railway is one of the most used means of transportation. For the railway system to operate flawlessly 

constant monitoring and inspection of railway tracks is required. Currently railway track inspection and 

monitoring is done manually which is time taking and not accurate, due to the high chance of human error 

occurrence. Moreover, practically it is impossible to inspect and monitor the railway track manually as they run 

thousands of miles. This paper describes the range of sensing technologies has expanded rapidly, whereas 

sensor devices have become cheaper. This has led to a rapid expansion in condition monitoring of systems, 

structures, vehicles, and machinery using sensors. Key factors are the recent advances in networking 

technologies such as wireless communication and mobile ad hoc networking coupled with the technology to 

integrate devices. It can be used for monitoring the railway infrastructure such as bridges, rail tracks, track 

beds, and track equipment along with vehicle health monitoring such as chassis, bogies, wheels, and wagons. 

Condition monitoring reduces human inspection requirement through automated monitoring, reduces 

maintenance through detecting faults before they escalate, and improves safety and reliability. This is vital for 

the development, upgrading, and expansion of railway networks. 

 

I. Introduction 
 Travel is fascinating, of them train travel is more exciting. With the increased comfort levels in train 

transport and traffic in trains we are in an extremely important situation to improve the safety concerns in train 

travel. This project explores the possible ways of increasing train track safety using on-board monitoring and 

dynamic track monitoring system. History shows that many train accidents have occurred because of track 

failure the recent one being in the year 2005 near Hyderabad where seven bogies of an express derailed over a 

bridge and many lives were lost. India with its increased technological inputs is in a demanding situation to 

counter this problem. Emulating the previous human based erroneous and procedural system where track 

monitoring is done twice in a year, our dynamic technology will enable the trains to run safely. The previous 

system had only track monitoring and no on-board transformation of the data dynamically, but this project 

proves its worth by providing solutions for the same. These systems are cost worth systems and on 

implementation can yield excellent results. India leading in the train track distance all over the world and with 

its varsity will be the best place to implement the system. Noteworthy things are dynamic speed control and user 

friendliness of this system. The system tackles almost all possible failure modes including collisions and how to 

counter them by the application of emergency brakes in the train. With the use of high end IoT system the 

consistency of the system is not a major concern. This system comes in two challenging models one of the 

version gets its power from solar and another from power line. Implementation is based on the viability of the 

area in which the sensor is deployed. Data losses are almost negligible in this system. For high traffic tracks, 

faster train monitoring are enabled using separate vibratory circuits placed at suitable areas to increase the 

consistency of the system and correlate the results. 

 In Onboard Dynamic Rail Track Safety Monitoring System , Abhisekh Jain S, Arvind S ,Balaji B.S 

Ram ,Viyas N.P,et al  aims at solving one of the long prevailing problems in the Railways. This simple method 

of continuous monitoring and assessment of the condition of the rail tracks can prevent major disasters and save 

precious human lives. Our method is capable of alerting the train in case of any dislocations in the track or 

change in strength of the soil. Also it can avert the collisions of the train with other or with the vehicles trying to 

move across the unmanned level crossings.  

 

II. Survey For Condition Based Maintenance In Railway 

 In  automatic railwaygate control using internet of things, G.Briundha, B.Perumal, C.Punithkumar, 

M.Sathyamoorthy, et al., delivered an automatic railway gate control at unmanned level crossing replacing the 

gates operated by gate keepers and also the semi automatically operated gates. It deals with the reduction of time 

for which the gate is being kept closed. In this system there is any crack in this track it gives intimation through 

the sensors. And also it has any object in this track means it gives intimation through arduino.   

In Railway Track Fault Detection System by Using IR Sensors and Bluetooth Technology, B.Siva  Rama 

Krishna, D.V.S Seshendra, G.Govinda Raja, T.Sudharshanand, K.Srikanth, et al.,  proposed designing of robust 
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railway crack detection scheme (RRCDS) using IR sensor assembly for railway track geometry surveying 

system by detecting the cracks on railway tracks. Most of the accidents in the train are caused due to cracks in 

the railway tracks, which cannot be easily identified. The manual inspection of railway track took more time and 

human fatigue. The proposed system introduces Bluetooth based technology, to prevent the train accident. Two 

IR sensors are installed at front end of the inspection robot which monitors the track and gives the the location 

of crack via Bluetooth to mobile phone. The proposed broken rail detection system automatically detects the 

faulty railway track without any human interference.  

 In Railway Track Security System, Ankita Jadhav, PallaviBhangre , Snehal Gaikwad, Amol 

Deshpande, et al., proposed the crack detection system in the rail tracks. This is to avoid rail accidents by using 

latest communication technologies. In this project GSM communication protocols are used to convey the 

message of crack detection via SMS. Crack detection is achieved by using the concept of eddy current losses 

implemented in the terms of darlington pair circuit. With the detection of cracks, the system also alerts the 

railway authorities facilitating the security system. 

 In Railway Track Monitoring and Accident Avoidance Using Smart Sensor Network , 

Anap.S.D.,Ronge Prasanna L.,Bhalerao Lalit P.,Dharme Sandip P, et al.,  expanded development in the railroad 

area has brought about an expansion in the train activity thickness over the world. This has brought about the 

expansion in the quantity of mischance including trains. In this paper, the proposed framework incorporates a 

few elements which forestall train mishaps. It incorporates flame recognition, water level identification, Railway 

track split discovery, This framework makes utilization of IR sensors, fire sensor, GSM and other inserted 

frameworks Rail mischance's have been expanded because of the surge streaming over the Railway tracks. We 

are proposing a surge identification framework to overcome such mischances. Here, at whatever point we 

distinguish that there is a flood over tracks; we will send a sign to the train through GSM which will stop the 

train furthermore send messages to higher powers of south focal railroad.  

 The existing system is condition monitoring. Condition monitoring detects and identifies deterioration 

in structures and infrastructure before the deterioration causes a failure or prevents rail operations. In simple 

condition monitoring, sensors monitor the condition of a structure or machinery. If the sensor readings reach a 

predetermined limit or fault condition, then an alarm is activated. 

 However, this simplistic approach may lead to a large number of false alarms and missed failures. It 

only provides local analysis but does not take advantage of the superior capabilities when the sensors are 

networked and their data processed collectively. Integrated data processing allows an overall picture of an 

asset’s condition to be achieved and overall condition trends to be determined. 

 In this paper we propose a system, if any human or animals presented in track, PIR sensor intimates it.   

If the ultrasonic sensor distance is low, railway gate will be opened. If the temperature of the crack goes to 

abnormal, LED will glow. If the humidity of the crack goes to abnormal, LED will glow to indicate corrosion 

produced in it. 

 The function of the IOT module being used is to send the current status of the sensor. Ultrasonic Sensor 

is used to find the Obstacles in front of the train and track. Here we have proposed the IOT to update the Current 

status of the sensor to the Base station and to update in the server room.   

 

III. Solution for enhanced maintenece. 
Programs written in Arduino are known as sketches. A basic sketch consists of 3 parts 

1.Declaration of Variables 

2. Initialization: It is written in the setup () function. 

3. Control code: It is written in the loop () function. 

 The sketch is saved with .ino extension. Any operations like verifying, opening a sketch, saving a sketch 

can be done using the buttons on the toolbar or using the tool menu. 

 The sketch should be stored in the sketchbook directory. 

 Chose the proper board from the tools menu and the serial port numbers. 

 Click on the upload button or chose upload from the tools menu. Thus the code is uploaded by the 

bootloader onto the microcontroller. 

 It comes with an easy provision of connecting with the CPU of the computer using serial communication 

over USB as it contains built in power and reset circuitry. 
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3.1.Block Diagram Of Transmitter Unit 

 

 
Fig 3.1 Block Diagram of transmitter unit 

 

3.2receiver Unit 

 

 

 

 

 

 

 

 

 

 

 

Fig.3.2 Receiver unit 

 

IV. Performance Comparison Of The Candidates For The Iot Networks 
An IoT network plays an important role of providing connections between a platform server and device 

platforms. Considering the current circumstance of the railway operators, there are two influential candidates for 

the IoT networks; LTE and LoRa. Many railway operators are already using GSM-R 

and will feel more familiar with LTE which is evolved from GSM. On the other hand, many in IoT 

industry keep eyes on LoRa, which newly arises and is specialized to serve lowpower IoT devices in a wide area 

In the aspect of power consumption, we let the terminals send small packets consistently and observed 

how much time it takes until the attached battery is exhausted. The average 

current of the LTE terminal is measured in the range of 333–351mA. Remarkably, the LTE terminals 

consume the similar amount of the power regardless of the received signal strength level, due to the unique 

power control mechanism in LTE. LTE specifies to control the transmit power of the 

control channel and the data channel independently, so the LTE terminal does not use the maximal 

transmit power when there is instantaneously no data to be sent. This happens frequently when the terminal 

sends small size packets periodically. So in the IoT scenario, the LTE terminal tends to consume a dominant 

amount of power on the basic processes rather than Radio Frequency (RF) transmissions. This fact gives us a 

guide that it is essential to lighten the basic processes, rather than to control the power amplifier exquisitely, for 

increasing the battery life of the LTE terminals. 

 

5.1 Arduino Software (Ide) 

 The Arduino Integrated Development Environment or Arduino Software (IDE)  contains a text editor 

for writing code, a message area, a text console, a toolbar with buttons for common functions and a series of 

menus. It connects to the Arduino and Genuino hardware to upload programs and communicate with them. 
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5.1.1 Tools 

 Auto Format  

 this formats your code nicely: i.e. indents it so that opening and closing curly braces line up, and that the 

statements inside curly braces are indented more. 

 Archive Sketch Archives a copy of the current sketch in .zip format. The archive is placed in the same 

directory as the sketch. 

 Fix Encoding & Reload Fixes possible discrepancies between the editor char map encoding and other 

operating systems char maps. 

 Serial Monitor Opens the serial monitor window and initiates the exchange of data with any connected 

board on the currently selected Port.  

 Board  

Select the board that you're using. See below for descriptions of the various boards. 

 Port  

This menu contains all the serial devices (real or virtual) on your machine. It should automatically refresh 

every time you open the top-level tools menu. 

 Programmer  

For selecting a harware programmer when programming a board or chip and not using the onboard USB-

serial connection.  

 Burn Boot loader The items in this menu allow you to burn a bootloader onto the microcontroller on an 

Arduino board.  

 

5.2 Tabs, Multiple Files, And Compilation 

Allows you to manage sketches with more than one file (each of which appears in its own tab). These can be 

normal Arduino code files (no visible extension), C files (.c extension), C++ files (.cpp), or header files (.h). 

 

5.3 Uploading 

Before uploading your sketch, you need to select the correct items from the Tools > Board and Tools > 

Port menus. The boards are described below. Once you've selected the correct serial port and board, press the 

upload button in the toolbar or select the Upload item from the File menu. Current Arduino boards will reset 

automatically and begin the upload.  

With older boards (pre-Diecimila) that lack auto-reset, you'll need to press the reset button on the board 

just before starting the upload. On most boards, you'll see the RX and TX LEDs blink as the sketch is uploaded. 

The Arduino Software (IDE) will display a message when the upload is complete, or show an error. 

When you upload a sketch, you're using the Arduino bootloader, a small program that has been loaded 

on to the microcontroller on your board. 

 It allows you to upload code without using any additional hardware. The bootloader is active for a few 

seconds when the board resets; then it starts whichever sketch was most recently uploaded to the 

microcontroller. The bootloader will blink the on-board (pin 13) LED when it starts (i.e. when the board resets). 

 

5.4 LIBRARIES 

 Libraries provide extra functionality for use in sketches, e.g. working with hardware or manipulating 

data. To use a library in a sketch, select it from the Sketch > Import Library menu. This will insert one or 

more #include statements at the top of the sketch and compile the library with your sketch. Because libraries are 

uploaded to the board with your sketch, they increase the amount of space it takes up.  

 If a sketch no longer needs a library, simply delete its #include statements from the top of your code. 

There is a list of libraries in the reference. Some libraries are included with the Arduino software. Others can be 

downloaded from a variety of sources or through the Library Manager. Starting with version 1.0.5 of the IDE, 

you do can import a library from a zip file and use it in an open sketch. See these instructions for installing a 

third-party library. 

 

5.5 SERIAL MONITOR 

 It Displays serial data being sent from the Arduino or Genuino board (USB or serial board). To send 

data to the board, enter text and click on the "send" button or press enter. Choose the baud rate from the drop-

down that matches the rate passed to Serial.begin in your sketch. Note that on Windows, Mac or Linux, the 

Arduino or Genuino board will reset (rerun your sketch execution to the beginning) when you connect with the 

serial monitor. 

You can also talk to the board from Processing, Flash, MaxMSP, etc (see the interfacing page for details). 

 

https://www.arduino.cc/en/Guide/Environment#boards
https://www.arduino.cc/en/Hacking/Bootloader
https://www.arduino.cc/en/Guide/Environment#boards
https://www.arduino.cc/en/Reference/Libraries
https://www.arduino.cc/en/Guide/Libraries
https://www.arduino.cc/en/Guide/Libraries
https://www.arduino.cc/en/Guide/Libraries
http://www.arduino.cc/playground/Main/Interfacing
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5.6 PREFERENCES 

 Some preferences can be set in the preferences dialog (found under the Arduino menu on the Mac, 

or File on Windows and Linux). The rest can be found in the preferences file, whose location is shown in the 

preference dialog. 

 

5.7 Language Support 

 Since version 1.0.1 , the Arduino Software (IDE) has been translated into 30+ different languages. By 

default, the IDE loads in the language selected by your operating system.  

 If you would like to change the language manually, start the Arduino Software (IDE) and open 

the Preferences window. Next to the Editor Language there is a dropdown menu of currently supported 

languages. Select your preferred language from the menu, and restart the software to use the selected language. 

If your operating system language is not supported, the Arduino Software (IDE) will default to English. 

You can return the software to its default setting of selecting its language based on your operating system by 

selecting System Default from the Editor Language drop-down. This setting will take effect when you restart the 

Arduino Software (IDE).  

Similarly, after changing your operating system's settings, you must restart the Arduino Software (IDE) to 

update it to the new default language. 

 

5.8 Boards 

 The board selection has two effects: it sets the parameters (e.g. CPU speed and baud rate) used when 

compiling and uploading sketches; and sets and the file and fuse settings used by the burn boot loader command. 

Some of the board definitions differ only in the latter, so even if you've been uploading successfully with a 

particular selection you'll want to check it before burning the boot loader. You can find a comparison table 

between the various boards here. 

 Arduino Software (IDE) includes the built in support for the boards in the following list, all based on 

the AVR Core. The Boards included in the standard installation allows to add support for the growing number of 

new boards based on different cores like Arduino Due, Arduino Zero, Edison, Galileo and so on. 

 

5.9 Schematic Representation 

 The schematic representation for the robotic model is been done using the PROTEUS.  

 

 
Fig 5.9.1 Schematic representation of robotic model 

 

 

https://www.arduino.cc/en/Products/Compare
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V. Conclusion 
 This paper presents a prototype for monitoring thestructural health of the railway tracks, automatic gate 

opening and preventing railway suicide. The prototype isstill under development with many new sensors to 

beincorporated for efficient study and monitoring ofrailways tracks.Complex computational techniques can be 

applied to sense any abnormal behaviour in the structure of therailway tracks.This method replaces manual 

inspection of the track section, by automatic inspection.This will help to detect cracks immediately and reduce 

the possibilities of any unfortunately happening. Since the system would be automatic and will require less 

manual intervention, the utmost efficiency of the system can be ensured. 
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